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From the President

By Suzie Campbell

Publisher of the Countywide & Sun * OPA President 2025-2026

What are some of the tips

and tricks you use when laying

out the paper or when com-

pleting other tasks, to keep the

paper running smoothly?

Here are a few that I will
share with you to adopt,
modify or ignore. The choice
is yours.

The first one I'll share has
been a game-changer.

It’s a common scenar-
io when rushing to meet a
deadline: you quickly pull a

photo and drop it on the page,

but you’re unsure what’s
happening or who the people
are. Then you spend time
you don’t have searching for
the information to write the
cutline.

We don’t do that anymore.
Whoever takes the photo is
responsible for writing the
cutline. Before the photojour-
nalist places the photo in the
file to be used, they open it in

Photoshop, then go to “image,

file info,” and in the descrip-
tion area, they type in the
photo credit information and
cutline.

If you have never done this,

here is a quick setup for you.
Place a photo on your In-
Design page. Then right-click
on the photo and scroll down
to comments. There will be a

Tips to streamline production time

tab to set up comments. Click
on it. A box will appear where
you decide if you want the
cutline to appear to the side
or below your photo. You will
also decide which box to use
under “file info” to add your
cutline information. I use the
description box.

Now, when I pull that pic-
ture into InDesign and place
it on the page, all I have to do
is right-click, scroll down to
comments and click “create
static captions.” A cutline ap-
pears under the photo. I might
do a little editing, but usually
it just needs to be formatted.

That’s another quick click
of the mouse. The cutline
formatting style is set up under
paragraph styles. In fact, text
styles for bylines, body, head-
lines, classifieds, photo credits
— just about anything you can
think of — can be pre-set in the
paragraph styles.

Another time saver, if you
use InDesign, is the Creative
Cloud (CC) library. In this
area, [ have multiple librar-
ies for things like filler ads,
standing ads, column headers
or some line art that you like
to use for various things.

If you have something you
want to save, click on the CC
library tab and then just click

on it and drag it over. It will
save it for later use. When you
want to use it, open the CC
library, scroll to the ad, art or
column header you want to
use, and click and hold while
you drag it to your page.

I have mine saved in
multiple folders just to make it
easier to find what I’'m looking
for. For example, I have a
folder for standing ads, one for
column headers and one for
filler ads.

Do you use QuickBooks?
Do you have invoices that are
the same every month? Mem-
orize that invoice. A box will
pop up asking you how often
you want this transaction to
occur, and for the next date it
will be used. I place all of my
memorized transactions in a
group file. Then, at the end of
the month, open the memo-
rized list, click on the group,
scroll down to the bottom and
find the gear-looking icon.
Click on that and then click
use.

Voila!

If you have some tips you
find helpful, share them. We
are all trying to save time and
streamline our work.

Download New Guidelines for Public Notices

On November 1, 2025, new rates for legal

notices and important reforms to improve

accessibility and readability of notices went

into effect. Download new guidelines at

okpress.com/public-notice-training

OPA CALENDAR
OF EVENTS

For more information
on upcoming events visit

okpress.com/events

JANUARY 15

2:00 - 3:00 PM

NA WEBINAR: DEEP DIVE INTO
COLOR:

Join Kevin Slimp for this intense
color class that explains how color
works and how to greatly improve
your photos. Start off 2026 with a
bang by getting inside your color
settings and making those photos
pop off the page!

JANUARY 19, 2026
1:00-2:00 PM

OMC WEBINAR: CREATING
SIGNIFICANT NEW OBITUARY
REVENUE

Find out the secrets to improving
your obituaries, selling more of
them and increasing both this
vital revenue as well as a major
readership feature.

JANUARY 22, 2026

ONF HOST NEWSPAPER
INTERNSHIP DEADLINE
Applications for the 2026 paid
summer internship program are
now available. The deadline for
host newspaper applications is
Jan. 16 and student applications
are due Feb. 18. The program is
made possible by a grant from the
Inasmuch Foundation.

FEBRUARY 19, 2026
OPA LEGISLATIVE SUMMIT
Join us at the State Capitol for the
annual Legislative Summit.

JUNE 5 & 6, 2026

OPA ANNUAL CONVENTION
Mark your calendar and make
plans to attend the annual con-
vention at the Norman Embassy
Suites Hotel & Conference Center.




OPA Board of Directors will consider
four membership applications in January

The OPA Board of
Directors will consider four
applications for membership
at its next meeting on January
15,2026.

ELLIS COUNTY STAR

Ellis County Star, a weekly
publication serving the Arnett
and Ellis County communities,
has applied for legal news-
paper membership in OPA.
The owner is Last Refuge
Media and publisher is Walter
Wagnon.

The Ellis County Star
maintains its office at 193001
E. County Road 68 in Arnett
and operates an online pres-
ence at elliscountystar.com.

Its first issue was on Sept.
22,2022, and it became a
General News Media member
of OPA in early 2024.

LAWTON TOWN CRIER
Lawton Town Crier has ap-
plied for Affiliate News Media
membership. The online-only
publication covering Lawton
is updated weekly at lawton-
towncrier.com. The owner is

Garrett Jackson; he started the
website in June 2025.

THE INDEPENDENT VIEW

The Independent View has
applied for Affiliate News
Media membership. It is an
independent student-run news
outlet that serves the Uni-
versity of Central Oklahoma
campus. The owner is listed as
The Independent View Board
with Joe Hight as financial
adviser. Its mailing address
is P.O. Box 44, Edmond, OK
73083 and website is theinde-
pendentviewuco.com. Its first
newspaper publication was on
Oct. 28, 2025, and is current-
ly published bi-weekly with
plans to move to a weekly
publication schedule in the
spring 2026 semester.

THE TREND

The Trend at the Univer-
sity of Science and Arts has
applied for Affiliate News
Media membership. The Trend
is an online-only student me-
dia website led by adviser JC

Casey, a USAO professor of
communication. The Trend’s
website is trend.usao.edu, and
the mailing address is 1727 W.
Alabama in Chickasha, OK
73018.

OBJECTIONS

Written protests to a mem-
bership application must be
received at the OPA by Jan. 5,
2026. Protests may be emailed
to OPA Executive Vice Presi-
dent Mark Thomas at mthom-
as@okpress.com or mailed to
Oklahoma Press Association,
3601 N. Lincoln Blvd., Okla-
homa City, OK 73105.

Any current member filing
a written protest will be enti-
tled to be heard by the Board
of Directors at the Jan. 15
meeting.

Information and application
forms for OPA’s membership
classifications may be found at
okpress.com/join. Lists of cur-
rent members may be found at
okpress.com/members.

a press release?

demands it?

You've Got Questions!

Can | photograph minors without consent?
Can police deny access to records by issuing

Should | alter my archives when a person

Can I report inaccurate testimony given in open court?
* What are the laws about liquor advertising?

These are questions answered by the attorneys for the OPA Legal Services
Plan members in recent months. OPA members always need timely legal
advice on issues related to publishing.

You should join OPA’s LEGAL SERVICES PLAN!

See www.OkPress.com/LSP or contact Mark Thomas
at (405) 499-0033 or toll-free in Oklahoma 1-888-815-2672 today!

Ihe Oklanoma
PUblisher

ISSN 1526-811X
Official Publication of the
OKLAHOMA PRESS ASSOCIATION

OPA OFFICERS

President
SUZIE CAMPBELL
Countywide & Sun

Vice President
ERIN DYER THOMPSON
El' Reno Tribune

Treasurer
BRIAN BLANSETT
The Lincoln County News

Executive Vice President
MARK THOMAS

OPA DIRECTORS

SHAUNA BELYEU
Past President,
The Eufaula Indian Journal

ED CHOATE
Muskogee, Oklahoma

BRETT WESNER
Wesner Publications

SHAUN WITT
Oklahoma Watch

CONNOR CHOATE
Marietta Monitor

JASON COLLINGTON
Tulsa, Oklahoma

KATHERINE MILLER
The Norman Transcript

OKLAHOMA PRESS ASSOCIATION
3601 N. Lincoln Blvd.
Oklahoma City OK 73105-5499
(405) 499-0020
Toll-Free in Oklahoma: (888) 815-2672
www.OkPress.com
news @ OkPress.com
www.Facebook.com/OKPress

SUBSCRIBE TO
THE OKLAHOMA PUBLISHER
$12 PER YEAR

THE OKLAHOMA PUBLISHER (USPS Pub
406-920), is printed Quarterly for $12 per
year by the Oklahoma Press Association,
3601 N. Lincoln Blvd., Oklahoma City,
OK 73105-5499. Call (405) 499-0020 to
subscribe. Periodicals postage is paid at
Oklahoma City, OK.

POSTMASTER: Send address changes to
The Oklahoma Publisher, 3601 N. Lincoln
Bivd., Oklahoma City, OK 73105-5499.

G Jaysiand ewoyepiQ 8y L | G20z Jequisdeg



> December 2025 | The Oklahoma Publisher

Monthly
Public Notice Journalism Contest

sponsored by

Oklahoma Press Service

The contest recognizes a
news story or series that:

(a) highlights the impact of a public notice or the
omission of a public notice,

(b) helps readers understand a specific public
notice, or

(c) explains the consequences of a public body’s
failure to publish a notice in a newspaper.

PUBLIC NOTICE CONTEST RULES

ELIGIBILITY:
Staff at all OPA legal newspaper and general news media
member publications as well as Individual members are
eligible to compete. Entries must have been previously
published in print or on the publication’s website. All entries
will compete together. One entry per writer per month will
be accepted.

HOW TO SUBMIT ENTRIES:
Each month, submit your entry at okpress.com/public-
notice-contest. Attachments should be in PDF format.
Entries may also be emailed (full-page tearsheet) to
amarshall@okpress.com. Include the author’s name, name
of publication and date of publication.

ENTRY DEADLINE:
All entries published in the previous month must be
received by OPA by the 15th of the current month.

AWARDS:
One winner per month will receive a Certificate of
Achievement, a $100 check and recognition in The
Oklahoma Publisher. Annual Sweepstakes winner will
receive a plague, a $200 check and recognition in The
Publisher.

ENTER ONLINE AT:
okpress.com/public-notice-contest

PUBLIC NOTICE

JOURNALISM CONTEST

OCTOBER 2025 WINNER

DEANNA MADDOX

Cushing Citizen

Propositions to be revisited due
to procedural error

PAGE 1 October 22, 2025

DEANNA MADDOX, Reporter

Cushing voters will be seeing three propositions that
were previously approved on an upcoming ballot after a
procedural error was made during the initial process.

An upcoming ballot may look familiar to Cushing
residents who voted in June of 2024 — three propositions
centered on Cushing charter changes in particular.
According to city legal counsel, the state requires a
public notice of proposed charter changes to be published
in a newspaper before such measures can be finalized.
This process was either not completed or not properly
submitted to the governor’s office resulting in a key legal
step being missed.

“There’s a newspaper publication requirement that’s
required for notice. The governor will not, should not
sign those documents... Unless we have all of the
required items — one of those is publication notice and
that’s the one that’s in question,” said Daniel McClure,
a legal representative for the City of Cushing. “So we’ll
have to go through the process again and make sure the
publication notice is turned in.”

The three propositions involve raising the city
manager’s purchasing cap, adjusting procedures for the
sale of city-owned property, and updating election filing
dates.

Read entire winning entry at
okpress.com/public-notice-contest



OPA assumes management of OCMA

The Oklahoma Press
Association recently assumed
management of the Oklahoma
Collegiate Media Association
(OCMA) from Oklahoma
State University with the sup-
port and cooperation of
OCMA’s long-standing direc-
tor, Oklahoma State Uni-
versity’s School of Media &
Strategic Communications.

OCMA’s mission is to em-
power student journalists, fac-
ulty advisers, and campus me-
dia organizations by providing
professional development,
networking opportunities and
recognition of outstanding
student media efforts.

Founded in1975 by former
OSU journalism school Di-
rector Harry Heath under the
name Oklahoma Collegiate
Press Association, the orga-
nization changed its name to
Oklahoma Collegiate Media
Association in fall 2010 to in-
clude recognition of websites
and multimedia created by
students.

Dr. Jared Johnson, director

Rodd Duff joins
Mangum Star News

Contest & Awards

Recognize outstanding

achievements in college
fournalism with U Statewide

| competition. %

of the OSU School of Media
& Strategic Communication,
continues to serve as OCMA’s
ex officio executive director.
“The Oklahoma Press
Association is proud to partner
with the Oklahoma Collegiate
Media Association as both
organizations are committed to
protecting the future of jour-
nalism and media programs
in our state. We look forward
to helping the next generation
of journalists thrive while cre-
ating more opportunities for
connection between student
journalists and professional
newsrooms around the state,”
said Lisa Sutliff, OPA Assis-

| Attend educational sessions
specifically designed for
student journalists and

Oklahoma Collegiate Media Association

Home About Membership Contest§Awards Conference Contact

ey

Empowering Student Me

From prestigious student media awards to prof
vibr

tant Executive Director.

Access essential resour
including FOI forms, helpful 1|
websites and other journdlism |

OSU faculty member
Brooks Garner guided the stu-
dent association from fall 1984
until his retirement in spring
2010. Associate Professor
Joey Senat continued the work
from 2010 through 2018.

OCMA will host its annual
conference on April 1 at OSU
in conjunction with the Paul
Miller Lecture Series.

“We look forward to work-
ing with college advisers and
students to provide resources,
professional development and
a collaborative community,”
said Sutliff.

For more information about
OCMA, see okcma.org.

as columnist

The Mangum Star-News
has a new columnist.

Rodd Duff, who recently
made Mangum his home, is
writing a column called “A
Corner of Insights.”

Prior to moving to
Mangum, Duff lived in Chi-
cago and southern Califor-
nia for more than 30 years,
where he built a machinery
company.

He made the decision
to relocate to Southwest
Oklahoma to be closer to
his children and grand-
daughters.

“I’ve traveled to all
50 states and much of the
world, but small towns like
Mangum are where the
American story still feels
real,” Duff said.

In addition to writing a
weekly column for the Star-
News, Duff also writes a
weekly Substack newsletter
under the INsights banner.

OKLAHOMA
CHICKASAW NATION GABVER
MEDIA RELATIONS Mia Waddell
Loné Beasley mewaddell @garverusa.com
580-559-0921 garverusa.com
lone.beasley @ chickasaw.net
chickasaw.net
GRAND RIVER
ETYPE SERVICES DA AUTHORITY
Thad Swiderski y
512-687-9055 918-256-5545
thad @ etypeservices.com justin.alberty @grda.com
stypeservices.com grda.com
FEED THE CHILDREN ~ MENTAL HEALTH
Kelly Frey ASSOCIATION
(405) 945-4064 OKLAHOMA
public.relations @ Amy Coldren
feedthechildren.org 405-778-8123
feedthechildren.org acoldren@mhaok.org
mhaok.org

STRATEGIC
PARTNERS

METRO CREATIVE
GRAPHICS
Jennifer Steiner
800-223-1600

jsteiner@metro-email.com
metrocreativeconnection.com

OGE ENERGY CORP.
Christi Woodworth
405-553-3698
woodwoco@oge.com
oge.com

OKLAHOMA
ASSOCIATION OF
ELECTRIC

COOPERATIVES, INC.

Nicki Fuller
405-478-1455
nfuller@oaec.coop
0aec.coop

OKLAHOMA OKLAHOMA
BAR ASSOCIATION NATURAL GAS
Lori Rasmussen Carson Cunningham
405-416-7016 405-830-8754
lorir@okbar.org carson.cunningham@
okbar.org onegas.com
oklahomanaturalgas.com
OKLAHOMA
DEPARTMENT OF OKLAHOMA STATE
REHABILITATION SCHOOL BOARDS
SERVICES ASSOCIATION
Brett Jones Christy Watson
(405) 651-4594 405-528-3571
bjones @ okdrs.gov christyw @ ossba.org
oklahoma.gov/okdrs.html ossba.org
OKLAHOMA MEDIA PHILLIPS
CENTER THEOLOGICAL
Rob Collins SEMINARY
405-205-9421 Kurt Gwartney
rob@oklahoma- 918-270-6470
mediacenter.com kurt.gwartney @ptstulsa.edu
oklahomamediacenter.com ptstulsa.edu
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Secondhand

The Lincoln County News office window features a personalized Christmas scene
painted by Chandler High School art student Lexi Martzall, who gave Santa a
Hawaiian shirt and surrounded him with elves taking photos and notes. The
cheerful Santa bears a striking resemblance to News Publisher Brian Blansett,
known for his frequent choice of Hawaiian shirts.

Photo by Emily Kalka, The Lincoln County News
STATEMENT OF OWNERSHIP, MANAGEMENT, & CIRCULATION
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The smoke from one cigarette affects
everyone in multiunit housing —
especially kids. Exposure to secondhand
smoke can lead to health issues, including:

e Asthma attacks & ear infections

e Absences from school & work

¢ Lung disease & multiple cancers

e |ncreased risk of addiction as adults

Learn more at

TOBACCO
STOPS WITH ME.com

A Program of
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Holiday gift
guide boosts
local business

Reid Newspapers offi-
cially kicked off the holiday
shopping season on Nov.

19 with the launch of its
“Oklahoma’s Grand Holiday
Gift Guide,” an online and
print showcase featuring
local deals, gift ideas and
seasonal favorites. The
guide appeared digitally and
in two special print editions,
offering readers a conve-
nient roundup of holiday
shopping opportunities.

Designed to boost visi-
bility for local businesses
during the year’s busiest re-
tail period, the guide provid-
ed participating merchants
with a variety of advertising
options. Each promotional
package included digital
media placement as well
as weekly print advertising
across Reid Newspapers’
many publications.

The promotion saw
strong participation across
the network of Oklahoma
newspapers owned by
Phillip and Jeanne Ann
Reid, including OPA mem-
bers Weatherford Daily
News, The Delaware Coun-
ty Journal, Nowata Star,
Miami News-Record, The
Grove Sun, Oologah Lake
Leader, Perry Journal, The
American in Afton and the
Vinita Daily Journal.

Adding to the excite-
ment, the guide featured a
QR code that readers could
scan to enter for a chance
to win $4,000 in Christmas
cash, encouraging en-
gagement and offering an
added incentive for holiday
shoppers.

The digital version of
“Oklahoma’s Grand Holiday
Gift Guide” can be viewed
at reidnewspapers.com/
Xmas.

OKLAHOMA SUPREME COURT:
Jail trusts not law enforcement

The Oklahoma Supreme
Court recently determined that
county jail trusts are not law
enforcement agencies under
the state’s Open Records Act.

This 6-3 decision, issued
on November 25, 2025, means
these trusts cannot use law
enforcement exemptions to
deny public access to financial
and operational records.

The ruling stems from the
case Lawson v. LeFlore Coun-
ty Detention Center Public
Trust. Bail bondsman James
Lawson requested specific re-
cords, including video footage
and employee names, after his

ex-wife had a confrontation
with a jailer while attempting
to bond out two inmates in Au-
gust 2023. The jail trust denied
the request, arguing it had the
same discretion to withhold
records as a police department
or sheriff’s office.

The majority opinion, writ-
ten by Justice Douglas Combs,
defined a “law enforcement
agency” as a body involved in
enforcing criminal laws and
initiating prosecutions. The
Court concluded that jail trusts
primarily house prisoners,
rather than actively investigate
crimes or file charges, classi-

fying them as general public
bodies subject to broader
disclosure rules. This affects
counties using trusts for jail
management, promoting ac-
countability.

Three justices dissented,
arguing for consistency be-
tween police-run and trust-run
facilities.

The full opinion is avail-
able on the Oklahoma Su-
preme Court network site,
https://tinyurl.com/mrxv52jx;
for PDF see https://tinyurl.
com/8y7hp42j

All About Network names Noak as marketing director

Michael
Noak has
joined The
All About
Network,
headquar-
tered in
Hennessey,
DRSNS S Oklahoma,
as Director of Marketing and
Sales.

Noak will guide the All
About Network into new op-

portunities that expand what it
can offer local advertisers.

The full-scale company, a
production of KJ FilmWorks
Inc., owned by Jack Quirk,
reaches communities across
northern Oklahoma.

This year alone, the compa-
ny’s combined platforms are
on track to surpass 50 million
views.

A native of Enid, Noak
graduated from Waukomis

2026 OPA PHOTO ID CARDS
ARE NOW AVAILABLE!!

they are covering.

Make sure you add a photo ID
press card to your toolkit.
These press cards help identify
reporters, photographers and
other staff members at events

Only $7 each!*

*plus $7 shipping per order

ORDER ONLINE AT

okpress.com/press-cards

High School and is a graduate
of Oklahoma State University
with a degree in Journalism,
Broadcasting and Advertising.
Prior to joining the All

About Network team, Noak
served as marketing director
for Advance Food Company
for 14 years and spent another
11 years as marketing director
for Atwoods Ranch and Home
Corporation.
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InDesign tips and a tiny thermal printer that delivers

G |
4 A

by Wilma Newby
wnewby @ okpress.com

n Computer Notes
== from the road
|

Just in time for the holidays
are some of the tips that I've
learned from you during my
road trips this past month.

First up are some InDe-
sign preferences to use when
copying and pasting from one
InDesign document to another.
This also works in a Word
processing program.

If you’re trying to bring
over information as it was
created with all the formatting,
try this:

On an Apple computer, go
to InDesign menu > Preferenc-
es; for Windows computers,
go to the Edit menu. Once
there, look for Clipboard han-
dling, then When Pasting Text
and Tables for other Applica-
tions.

Clipboard Handling

Clipboard
() Prefer PDF When Pasting

Copy PDF to Clipboard
[ Preserve PDF Data at Quit

When Pasting Text and Tables from Other Applications
Paste:

© All Information (Index Markers, Swatches, Styles, etc.)
O Text Only

Show Paste Options.

Show Auto Style Option

Check the All information
(Index Markers, Swatches,
Style, etc.) box. This brings
in all formating with the copy
when pasting text instead of
text only.

This is a double-edged
sword as all the styles that

were used in the copy are
brought in and may create
conflicts. But it helps in most
cases.

Another way to import
text into InDesign is to Place
text documents. Go to File >
Place... In the next window
check the box that says Show
import options. Select the file
you want to import and click
Open. The next window gives
you several options. If you’re
placing a PDF, you can choose
what page to import. If it’s text
you’re placing, you can select
whether to remove or preserve
the styles when the document
is placed.

The “place command”
with plain text documents is
extremely useful. If the text
file you’re importing is full
of spaces instead of tabs, try
these next steps. Just remem-
ber that the file must have the
extension .txt.

Make sure Show Import Op-
tions is checked and look for
the box that says Formating.
Under that, check Replace 3
or more Spaces with a Tab and
Remove Between Paragraphs
to get rid of extra returns
between paragraphs.

Extra Carriage Returns
[ Remove at End of Every Line

Remove Between Paragraphs

Formatting

Replace | 3 or More Spaces with a Tab

Use Typographer's Quotes

This feature can remove
extra paragraph returns in a
document eliminating the need
for Find /Change after the copy

is brought in. Just remember
that the document must be a
plain text (.txt) file for this to
work in InDesign. If the file is
a .docx or .doc file try opening
it in a word processor program
such as LibraOffice or Micro-
soft Word. In those programs
go to Save as and under File
Type choose Text or Plain text
with .txt as the file extension.

Now you can place the file
in InDesign without the extra
spaces and returns.

If you find the file has a lot
of extra characters that you
don’t want, try this trick.

Select one of the characters
you want to delete and go to
Edit > Copy. Now go to the
Edit menu > Find/Change and
paste the character into the
Find what box. In the Change
to box choose what you want
the item to be replaced with —
it can be nothing, a tab, space
or another character. To find
special functions, look under
the “@” at the end of the line.

L] Find/Change

Query: | [Custom]

|Text| GREP | Glyph | Object

Find what:

~] @

Change to:
At v @

Search: Story v

In the Search box select
Story or Document depending
on what the file needs.

If your document has in-
consistent spaces where there
should be one tab, choose the
longest string of spaces and
copy them to the Find What

> LEGAL ADVICE

Eict

is just one of the benefits of being a member of the Oklahoma Press
Association’s Legal Services Plan. Remove the worry of needing
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION'S
LEGAL SERVICES PLAN

1-888-815-2672 or 405-499-0020

box. Replace that with a tab
(™). After that, eliminate one
space in the Find What box and
replace again. Keep going un-
til it gets down to three spaces.

THERMAL PRINTER

A publisher at a member
newspaper has been experi-
menting with a thermal printer
to print labels for their small
circulation publication.

Jiose shipping label printers
are direct thermal printers
capable of printing barcode
labels. As of this writing, it
retails for $39.99 on Amazon.

The 17 X 4” labels cost $36
for six rolls of labels. This is
less expensive than the three-
up Avery labels the newspa-
per was using. A metal label
holder for $8 has been useful
in holding the rolls.

These inexpensive thermal
label printers were intend-
ed for home use to print off
packing labels. At this price it
could be replaced four times
for what a dot matrix printer
would cost. For example, the
Epson FX-890II dot matrix
printer retails for $400, but the
paper labels it uses are cheaper
than thermal. And, Epson
printers have proven to last for
many years.

If you’re interested in
trying a thermal printer, the
initial cost would run around
$94, which includes the Jiose
printer with 1X4” labels and
label holder. After that the
only cost would be the labels
since no ink or ribbons are
needed. A side benefit of this
printer is that it’s a lot quieter
than the dot matrix printer.

However, I’'m not sure
how this little printer would
hold up for large circulation
publications.

OPA Computer Consultant Wilma
Newby’s column is brought to you by
the Oklahoma Advertising

Network (OAN). For more information
on the OAN program, contact Oklaho-
ma Press Service at (405) 499-0020.



OCTO B E R 2025 Wl N N E RS All entries judged by members of the Oklahoma Journalism Hall of Fame

Multi-Day & Online-Only Photo Winner: Weekly Photo Winner:
JASON ELMQUIST KATHLEEN GUILL

Frederick Press-Leader

OGE Energy Corp. provides monthly winners with a $100 check and certificate. Sweepstakes winners receive $200 and a plaque from OGE.
Contest open to staff at OPA Legal Newspaper and General News Media members, as well as OPA Individual members.
Complete contest rules and online submission form available at okpress.com/oge-photo-contest.

View winning photos at okpress.com/oge-photo-contest

Editorial Winner:
M. SCOTT CARTER

Column Winner:

DEANNA MADDOX

Cushing Citizen Southwest Ledger

The Value of a Staycation Under the Dome: For the record,

As some may know, I took a vacation last week. One Senator Jett is wrong
of the main things people wanted to know was where |

was going and what I would be doing for the vacation.
The assumption is always that a vacation means packed
suitcases, a full itinerary, and perhaps a boarding pass.
While I took a brief trip, the majority of my vacation
was spent at home having a staycation.

I didn’t have the funds or time for a grandiose expe-
rience — kids still had to get to school, doctor appoint-
ments had to be scheduled, and everything had to be
cleaned. However, I never needed grandeur to relax, in
fact, I prefer the opposite. The mundane task of every-
day life feels completely different when you don’t have
to squeeze it in between workdays. Even folding clothes
is relaxing when there’s no deadline to chase.

So I slowed down. I leaned into the rhythm of the
week instead of rushing through it. I took the time to
simply enjoy all the things that had to be done. I re-
watched movies, undistracted, giving me fresh eyes.

Even before its birth as a state, Oklahoma has been
home to what can only be described as robust political
debate.

Through the years, the issues have been lofty and the
emotions intense.

And still, the debate over issues and the ideas that
impacted state government helped shape and mold
many state laws and policies. In addition, whether or
not you disagree with those involved, by and large our
debate has been civil.

Until now.

For the past couple of weeks state Sen. Shane
Jett has spent a great deal of time — and social media
bandwidth — trying to convince his fellow Oklahomans
that the Department of Human Services is an evil entity
with the sole purpose of taking people’s children.

Jett has moved debates about policy to threats, lies
and an invitation to violence.

Oklahoma Natural Gas provides monthly winners with a $100 check and certificate. Sweepstakes winners receive $200 and a plaque from ONG.
Contest open to staff at OPA Legal Newspaper and General News Media members, as well as OPA Individual members.
Complete contest rules and online submission form available at okpress.com/ong-contest.
Views expressed in winning columns and editorials are those of the writers and don’t necessarily reflect the company’s opinions.

Read winning columns and editorials at okpress.com/ong-contest
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Community papers shine with heartfelt features

Looking

Them Over
by Rod Serfoss
rserfoss @ okpress.com

For its Thanksgiving
edition, The Purcell Register
asked local second graders
what they thought it was like
for the Pilgrims at the very
first Thanksgiving celebration,
what they ate, who was there,
if they played any games and
what is the student’s favorite
part of the holiday.

Mercerxl);lartln ELEC'LED

0OU Stud

has new
sales rep

the holiday for most of today’s
elementary students is spend-
ing time with family, though
one added “making deviled
eggs with her family.”

No matter how old you are
or where you live, this is good
reading — and good reading
sells newspapers.

Lincoln County News
writer Emily Kalka pinned an
excellent feature story about a
local school student that was
injured during the wildfires
that swept through Lincoln
County on March 14. That
fire also claimed the life of his
father.

Turmng tragedy into

Trlumph

Indomitable
Will Conley

Several agreed there was
turkey, mashed potatoes and
pumpkin pie at the gathering,
but one said they had bread
and fish to eat, and another
listed pancakes and eggs.

One student imagined,

“It was exciting! It was mostly
women and men” but she
didn’t know if they had any
visitors ...

Another said, “There were
no visitors, just pilgrims.”

One second grader re-
sponded, “Yes, they had some
Indians that were visitors and
it lasted forever.”

When asked what games
were played, responses ranged
from there being no games
to playing soccer, tag, Candy
Land, checkers, board games
and UNO.

According to the Register,
in general, the favorite part of

Kalka’s lead for the story
was excellent.

“Will Conley is determined
that nothing is going to stop
him.

“Despite severe burns over
60 percent of his body and
losing his left hand and all the
fingers on his right, he still
shows up at wrestling — both
for the high school team and
for the local youth league, ea-
ger to cheer on his teammates
and younger brothers, as well
as step in as a mentor.”

“If I can still be a part of
the team and just be with
them, then I’ll do whatever it
takes to just be with the team
whenever I can,” he said,
sitting in the wrestling room at
the high school on Nov. 6.

While the story goes into
detail of the many hardships

he deals with on a daily basis,
those are quickly overshad-
owed by his positive attitude
and willpower to move for-
ward and get back on the mat
for his junior or senior year.

A regular column in the
Coalgate Record-Register,
titled “Around Town......
by John Bill Martin,” always
leaves a smile on readers’
faces.

Recently Martm pubhshed
“The New Alphabet,” a
spinoff from the grade school
days when youngsters were
asked to come up with words
for each letter in the alphabet.

“Don’t think the kids would
appreciate this NEW alphabet,
but those of us in a certain age
group can certainly identify,”
wrote Martin.

His list contains an “is for”
for all 26 letters of the alpha-
bet. Here are a few examples:

“A s for arthritis

“B is for the bad back

“C is for the chest pains

“G is for gas

“H is for high blood pressure

“K is for knees that crack
when they bend

“Q is for queasy

“U is for urinary troubles”

He concludes the column
with, “I’ve survived all the
symptoms, my body’s de-
ployed And I’m keeping 26
doctors fully employed!!!”

When The Healdton Her-
ald goes to high school sport-
ing events it covers the entire
event and not just the game.

The Herald’s Nov. 20,
2025, edition included numer-
ous pictures of the Healdton
High School football players
in action but readers were also

THE HEALDTON

chool board filis
eriod December 1-3|

treated to so much more. They
got to see pictures of the “loud
and proud” student section,
adults showing off their
streamers and greeting players
as the team took the field, the
band playing the fight song af-
ter a touchdown, cheerleaders
keeping the excitement going,
students celebrating with

the school mascot, coaches
interacting with players and so
much more.

The Herald’s coverage is a
good example on how to grow
circulation. By reporting about
the event — and not just the
game — readers who are not
interested in the play-by-play
are lured to buy a newspaper
to see names and pictures of
fans, family and friends.

TOP FIVE HEADLINES:

5. Hunt Turns into Unfor-
gettable Experience
— Stigler News-Sentinel

4. Masked man threatens
to shoot if victim doesn’t
buy him booze
— Broken Bow News

3.  Who says you can’t
come home?
— The Ardmoreite

2. City roadway renamed
for Gypsy
— Yukon Progress

1. Who done it? — Cherokee
Messenger & Republican

OPA Business Consultant Rod
Serfoss looks over OPA member
publications for “Looking Them Over,
a monthly column. To contact Serfoss,
email rserfoss @ okpress.com.



Member Visits

Last month OPA President Suzie
Campbell, publisher of the Countywide &
Sun, and OPA Executive Vice President
Mark Thomas hit the road to visit a few
member publications.

Campbell and Thomas stopped at
The Davis News, The Healdton Herald,
Johnston County Sentinel, The Madill
Record, Marietta Monitor and Sulphur
Times-Democrat where they were
welcomed by publishers and other staff
members.

Kathy and James John, owners and publishers of the Sulphur
Times-Democrat pose with OPA President Suzie Campbell
(center).

Christi Blakemore, publisher of The Wilson Post-Democrat and The
Healdton Herald, displays the latest editions of the weekly newspapers.

Standing in front of the mural on the east side of the Marietta Monitor building in downtown
Marietta are Co-Publisher Willis Choate, writer Linda Hicks and OPA President Suzie Campbell.
The mural was painted by Brent Greenwood, fine arts director for the Chickasaw Nation of Okla-
homa, and his team.

A i
Alisha Thompson, owner and publisher of The Davis News, welcomes OPA President Suzie Camp-
bell and OPA Executive Vice President Mark Thomas to her office.
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EDWIN éEDDIE) LEW
MORRIS JR. , a longtime

employee of the Newspaper
Printing Corporation, died No-
vember 19, 2025. He was 77.
Morris was born July 15,
1948, in Ponca City. He grad-
uated from Ponca City High
School and attended Northern

DEATHS

Oklahoma College in Tonka-
wa.

Morris worked as a District
Sales Manager for the News-
paper Printing Corporation in
Tulsa for more than 20 years,
and as District Sales Manager
for Gannett Publishing out
of Springfield, Missouri, for
more than 17 years.

In 1994, he moved to
Springfield and became a
realtor.

Morris is survived by his
son, Brent Edward Morris of
Ozark, Missouri; a sister, Sara
Lynn Butler of Ponca City;
two grandchildren; and two
nephews.

EMMA ROSE MOORE, -

former editor of the Vinita
Daily Journal, died November
9, 2025. She was 98.

Moore was born Novem-
ber 17, 1926, on her father’s
Cherokee allotment. After
graduating from high school,
she attended Oklahoma
Baptist University in Shawnee
and later, the University of
Oklahoma.

When she was only 17
years old, she was named as
city editor of the Vinita Daily

Journal, which began a life-
time career in journalism that
spanned several decades with
numerous publications.

Moore was an award-win-
ning civic leader. Two of her
most notable awards were
induction into the Vinita
Chamber of Commerce Hall
of Fame and recognition from
the Association for Women in
Communications.

In the 1960s, Moore
received a teaching certificate
from Northeastern State in
Tahlequah. She taught English

and journalism at Vinita High
School.

She moved to Cordell,
Oklahoma, in her later years.
A hometown send-off when
she left Vinita included the
mayoral proclamation of
“Emma Rose Moore Day.”

Moore is survived by three
children, Mary Gail Brown of
Bessie, Okla., Curtis Moore of
Edmond and Glen Moore of
Owasso; nine grandchildren;
and 23 great-grandchildren.

RECENT DONATIONS:
Clytie Bunyan | Barb Walter in memory of Dick Hefton

Please donate to the Oklahoma Newspaper Foundation online at okpress.com/donations.

James Arthur ‘Jim’ Perry
December 25, 2024

Remembering our friends & colleagues who died the previous year:

Oran C. Redden
December 12, 2024

Kenneth Owen ‘Ken’ Reid
December 9, 2024
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